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Abstract—The colour vision system of bees and humans differs mainly in that, contrary to humans, bees are 
sensitive to ultraviolet light and insensitive to red light. The synopsis of a colour picture and a UV picture is 
inappropriate to illustrate the bee view of flowers, since the colour picture does not exclude red light. In this study 
false-colour pictures in bee view are assembled from digital photos taken through a UV, a blue, and a green filter 
matching the spectral sensitivity of the bees’ photoreceptors. False-colour pictures demonstrate small-sized colour 
patterns in flowers, e.g. based on pollen grains, anthers, filamental hairs, and other tiny structures that are inaccessible 
to spectrophotometry. Moreover, false-colour pictures are suited to demonstrate flowers and floral parts that are 
conspicuous or inconspicuous to bees. False-colour pictures also direct the attention to other ranges of wavelength 
besides ultraviolet demonstrating for example blue and yellow bulls’ eyes in addition to UV bulls’ eyes which 
previously have been overlooked. False-colour photography is a robust method that can be used under field conditions, 
with various equipment and with simple colour editing.  
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INTRODUCTION 

Flowers serve as filters signalling attractants for 
pollinators as well as deterrents for flower antagonists (Junker 
& Blüthgen 2010). Due to differences in the number of 
photoreceptors types, the spectral range of sensitivity of the 
colour photoreceptors, and differences in the colour 
preference of various flower visitors, flowers can be attractive 
to pollinators and unattractive to illegitimate visitors, i.e. 
pollen thieves and nectar robbers, at the same time (Lunau & 
Maier 1995; Lunau et al. 2011). Since many flower visitors, 
such as hummingbirds (Herrera et al. 2008), bats (Winter et 
al. 2003), bees (Peitsch et al. 1992), hoverflies (Lunau 2014), 
beetles (Martínez-Harms et al. 2012), butterflies and moths 
(Kelber et al. 2002; Arikawa 2003) are sensitive to ultraviolet 
light, these flower visitors necessarily view different aspects of 
the spectral reflectance of flowers as compared to UV-blind 
humans. Many of these flower visitors possess a different 
number of colour photoreceptor types compared to humans, 
e.g. one in bats, two in beetles, three in bees, four in 
hummingbirds and flies, and from three up to fifteen in 
butterflies (Briscoe 2008; Chen et al. 2016). This results in 
colour vision systems hardly conceivable to that in humans. 
However, bees have trichromatic colour vision just like 
humans, but are sensitive to ultraviolet, blue and green light 
rather than blue, green and red light as humans (Peitsch et al. 
1992; Fig. 1). Neuronal processing of colour photoreceptor  

 

FIGURE 1. Spectral sensitivity of colour photoreceptors. Top: 
Relative sensitivity of the three human photoreceptor types. The 
curves peak at 420 nm, 534 nm and 564 nm (Bowmaker et al. 1980). 
In the UV range of wavelength between 300 nm and 400 nm the 
photoreceptors are not sensitive (modified from Stockman et al. 
1993). Bottom: Relative sensitivity of the three photoreceptor types 
of the honeybee (Apis mellifera). The curves peak at 344 nm, 436 
nm and 544 nm. In the red range of wavelength between 630 nm and 
700 nm (red light) the photoreceptors are not sensitive (modified 
from Peitsch et al. 1992). 

inputs in bees and humans is similar, both bees and humans 
have colour opponent neurons (Backhaus 1991) and colour 
constancy (Neumeyer 1981). To understand flower colours 
and floral colours pattern as bees might see them Kevan 
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(1978, 1979, 1983) claimed the need for a bee-subjective 
colorimetric analysis of flower colours. 

Three methods are frequently used to study floral colours 
and colour patterns as perceived by bees. The measurement of 
the spectral reflectance by a spectrophotometer allows for the 
comparison of the spectral reflectance of a floral tissue with 
that of a black standard and of a white standard. A database 
provides access to spectral reflectance measurements for many 
plant species (Arnold et al. 2010). Reflection spectroscopy is 
limited by the size and surface properties of the measuring 
spot, which does not allow for measuring the reflectance of 
small-sized, curved or rough-textured structures like pollen 
grains, stamens, and filamental hairs. The standard method of 
reflection spectroscopy is a measurement angle of 45° without 
integrating sphere (Chittka & Kevan 2005; but see Stavenga 
& van der Kooi 2016). This method largely ignores the impact 
of the surface of petals being flat, conical or other, since most 
white standards possess a smooth if not glossy surface. 
Moreover, the transparency of the petals is ignored, since the 
flower, e.g. a petal, is placed on different backgrounds being 
black, white or another petal for measurements, which 
disregards light shining through the petal from the backside 
and the impact of the colour chosen as background.  

Another method is the synopsis of a colour picture and a 
UV-picture showing the flower as appearing to humans and 
the ultraviolet reflection pattern on different pictures 
(Daumer 1958; Silberglied 1979). This method possesses the 
disadvantage that the readers might be successful in notionally 
superimposing the colour picture and the UV-picture but fail 
to eliminate the red content of the colour picture at the same 
time. Red, however, is a component of yellow, magenta, purple 
and white colours. Moreover, the interpretation of UV-
pictures showing UV-absorbing parts of flowers is sometimes 
misleading, e.g. if it is concluded that red and UV-absorbing 
parts are invisible to bees (Chittka & Waser 1997). A 
television camera equipped with UV-transmitting lens and 
UV-transmitting filter allowed direct observation and 
recording on video tape (Eisner et al. 1969; Silberglied 1976; 
Gronquist et al. 2001). Also, a modified image converter and 
image amplifier combined with UV-transmitting filter and 
UV-transmitting lens enabled to screen the UV-reflectance 
properties of many flowers (Rosen & Barthlott 1991) in the 
field. However, classical UV-photography using a UV-
sensitive camera mounted on a tripod, UV-transmitting filter 
and UV-transmitting lens and a UV-sensitive film were still 
preferred to produce UV-photos with high quality (Biedinger 
& Barthlott 1993; Burr & Barthlott 1993; Burr et al. 1995; 
Lunau 2000). With the turn of the millennium, digital 
cameras were used mostly after having their internal UV- and 
IR-blocking filter removed and sometimes with the support 
of a UV-lamp for illumination (Koski & Ashman 2013). 

Several attempts have been made to develop methods to 
create colour pictures in bee view. As early as in 1958 Daumer 
tried to evaluate floral colours considering the bees’ colour 
perception. He took photographs with a yellow, a blue and a 
UV filter and calculated the “bee-colour” (Daumer 1958), 
but of course he did not have the option to merge the 
photographs to a bee view-picture. Vorobyev et al. (1997) 
developed a method based on video recordings of flowers 

made by a UV-sensitive camera and specially selected set of 
filters to reconstruct images of flowers as bees might see them 
by calculating the quantum catches of the honeybee 
photoreceptors for each ommatidium dependent on the 
distance between bee and flower. Multispectral images, a series 
of black-and-white photos taken through different bandpass 
filters (Kevan 1972; Chittka and Kevan 2005) from alpine 
flowers of the Rocky Mountains, Colorado, are available from 
the Floral Image Database (http://liu.edu/flower). Benitez-
Vieyra et al. (2007), Williams & Dyer (2007), Brito et al. 
(2015) and Hempel de Ibarra et al. (2015) presented false 
colour photos of flowers in bee view, some of which require 
sophisticated calculations or calibrations. Photographic 
methods have also been used for simultaneous quantitative 
measurements of spatial and spectral components of floral 
colour patterns as seen by bees (Vorobyev et al. 1997; Benitez-
Vieyra et al. 2007; Williams & Dyer 2007; Hempel de Ibarra 
& Vorobyev 2009; Garcia et al. 2014; Hempel de Ibarra et al. 
2015; White et al. 2015). 

Recent studies presenting multispectral images from 
flowers in bee view (Garcia et al. 2014; Brito et al. 2015; 
Hempel de Ibarra et al. 2015; White et al. 2015; Vasas et al. 
2017) are mostly focusing on one or few target species and 
/or require sophisticated calculations or calibrations. In this 
study we introduce a simple and cheap method for general use 
based on a slightly modified and supplemented standard 
camera equipment to create UV-pictures and false-colour 
pictures in bee view and to highlight the rationale of this 
method for field studies. The estimated prices for a low-cost 
and a standard equipment as used in this study are shown in 
Supplement S1. This equipment is much less expensive than 
custom-built multispectral cameras, e.g. Spectrocam 
Multispectral Wheel Cameras (Ocean Optics). The pictures 
are intended to demonstrate the bee-subjective colour patterns 
of flowers in bee view with details that cannot be measured 
using a normal spectrophotometer. Moreover, it is 
demonstrated how false-colour pictures in bee view are used 
to better understand the impact of the bees’ sensitivity for 
ultraviolet and insensitivity for red light. For this purpose, 
false-colour pictures of floral colour changes and small-sized 
floral structures are shown as false-colour pictures. In 
addition, yet undescribed forms of colour patterns are 
described using false colour pictures such as blue bull’s eyes 
rather than ultraviolet bull’s eyes (Silberglied 1979; Koski & 
Ashman 2014). The robustness of this method is tested by 
the comparison of false-colour pictures taken with different 
cameras, lenses, filters, different picture editing programs and 
in field conditions. 

MATERIALS AND METHODS 

False-colour photography of flowers and floral colour 
patterns in bee view is an extension to the well-established 
UV-photography. The editing of digital pictures allows to 
split a colour picture into the colour channels and to 
reassemble a colour picture from the colour channels and thus 
to use a UV-channel instead of blue, a blue channel instead of 
green and a green channel instead of red in order to shift the 
range of wavelength for about 100 nm. To match the bee 
photoreceptors’ sensibility as close as possible specific filters 
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might be used. Here the principal method of false-colour 
photography is described and the quality of results obtained 
with different equipment and with different processing is 
compared. 

Equipment 

To capture photos in bee view we used a modified 
Panasonic GH-1 camera. The low-pass filter was removed in 
order to increase the sensitivity for ultraviolet light. We used 
an Ultra-Achromatic-Takumar 1:4.5/85 lens made of fused 
quartz that transmits UV light. Since the modified camera is 
sensitive to ultraviolet and infrared light, we used a UV-/IR-
Cut filter to capture a normal reference picture. This filter 
transmits light between 400 nm and 700 nm only (Fig. 2). To 
simulate the spectral sensitivity of typical bee photoreceptor 
types we used special filters that only transmit light of certain 
ranges of wavelengths (Fig. 3). Other equipment used 
included a Nikon D40 camera with low-pass filter, a 18-55 
mm Nikkor lens and a 105 mm UV-Nikkor lens. In addition, 
only a UV picture and a colour photo split into the colour 
channels were used for picture processing (see below). A 
robust tripod and calm conditions are necessary for taking the 
different photos since changing the filter in between can be 
time-consuming. A white Teflon disc reflecting equal 
amounts of light in a range of wavelength from 300 nm to 
700 nm was used for manual white balance before taking 
photos. Alternatively, a 20% Spectralon Grey Standard was 
used (see below). 

Photography 

Since most flowers are small we set the aperture values 
between f/8 and f/16 to ensure good image resolution. The 
exposure time and ISO value of the camera were adjusted to 
the daylight. All pictures were focused manually because the 
viewfinder is completely dark after attaching the UV 
transmitting filter. Four photos were taken, one photo with 
UV-/IR-Cut filter, one photo with the UV filter, one photo 
with the blue, and one photo with the green filter. All pictures 
were saved in the camera's RAW format. This allows to adjust 
the white balance in post-production. As a reference we used 
a Spectralon Grey Standard that reflects all wavelengths of the 
needed 300 nm to 700 nm spectrum with 20%. The grey  

 

FIGURE 2. Relative transmission of the UV-/IR-Cut filter 
(Baader). Only light between 400 nm and 700 nm can transmit the 
filter (changed according to Baader Planetarium 2017). 

 

FIGURE 3. Relative transmission of the three colour filters 
(Baader). Violet: UV-filter transmits UV light only. Blue: Blue filter 
that only transmits blue light. Green: Green filter that only transmits 
light of the green part of the spectrum (changed according to Schmitt 
K., personal communication, 21. September 2015). 

 

FIGURE 4. The splitting and merging process in detail. 

reference was captured for every channel (normal, blue, green, 
UV) with the flowers or in separate pictures and always under 
the identical light and with identical camera settings. 

Picture editing 

The pictures taken with the UV, blue, and green filter 
were split into the colour channels in order to convert the 
merged picture into the RGB system which is visible for 
humans. From the picture with UV filter the red channel, 
from that with blue filter the blue channel, and from that with 
green filter the green channel was used for merging (Fig. 4). 
In windy conditions the frequent change of filters might not 
be useful. The alternative option is to take only two photos, 
one with the UV-/IR-Cut filter and one with the UV-filter. 
The photo taken with the UV-/IR-Cut filter then is split to 
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the colour channels and the merging of the false-colour photo 
is done with the split colour photo and the split UV photo. 
To merge the channels to a bee view picture all captured 
pictures were pre-adjusted using Adobe Lightroom CC 
(version 2015 or newer). The merging was done in Photoshop 
or ImageJ. Moreover, preset white balance values can be used 
to reduce time between the two photos. 

If only two photos were taken using manual white balance 
with a white and UV-reflecting Teflon disc, one photo was 
taken with UV-/IR-Cut filter and one with the UV-filter. 
Then the picture taken with the UV-/IR-Cut filter was split 
into the colour channels and the blue and green channels were 
used for merging. The red channel was discarded. Also, the 
photo taken with the UV-filter was split into the colour 
channels and the red channel was used for merging. In 
addition, we resigned the use of the RAW format or used a 
modified Nikon D40 camera and a plastic lens Nikon AF-S 
DX NIKKOR 18-55 mm. The merging was done in 
Photoshop or ImageJ. 

For producing false-colour pictures the UV channel was 
converted to the new blue channel, the blue channel to the 
green, and green channel to the new red channel (Fig. 5). To 
analyse the pictures the following colour translation chart is 
useful (Tab. 1). For a picture that shows colours in bee view 
we need a UV, a blue and a green colour channel. These three 
colour channels need to be converted into the RGB system, 
which is visible for humans. Since the red channel is not 
needed it can be discarded. The bees’ S-type of photoreceptors 
is sensitive for UV light. The humans’ S-type of 
photoreceptors is sensitive for blue light. As a consequence, 
we convert the UV channel to the new blue channel, the blue 
channel is shown as green and green as red. 

Grey Standard 

All pictures were saved in the camera's RAW format. This 
allows to adjust the white balance in post-production. As a 
reference we used a Spectralon Grey Standard Labsphere SRS-
20-010 that reflects all wavelengths of the needed 300 nm to 
700 nm spectrum with 20%. The grey reference was captured 
for every photo, resp. channel (normal, blue, green, UV) with 
the flowers or in separate pictures and always under the 
identical light and with identical camera settings. To merge 
the channels to a bee view picture all captured pictures were 
pre-adjusted using Adobe Lightroom CC (version 2015 or 
newer). 

Preparing the pictures using Adobe Lightroom 

By using the histogram in Adobe Lightroom we adjusted 
the pictures so that the containing grey standard has the same 
brightness in all pictures. The histogram shows how many 
pixels in a picture (y-axis) have a certain brightness (x-axis). 
This is shown for the blue, the green and the red channel. 
Since we only use the blue channel of the picture captured 
with the blue filter, the brightness of the picture was adjusted 
so that the peak of the blue channel is exactly in the middle of 
the histogram (Fig. 6). We did the same with the peak of the 
green channel in the picture that was captured using the green 
filter. Because red channel of our cameras seems to be more 
UV sensitive than the other channels we adjusted the UV 
picture so that the peak of the red channel is in the middle of 
the histogram. In pictures where we captured the grey standard 
separately we adjusted the picture containing the grey standard 
and copied the values to the picture containing just the flower.

FIGURE 5. Colour picture of 
the ram’s horn Proboscidea 
louisianica (Martyniaceae) showing 
the human view and false-colour 
picture showing the bee view. The 
merging of the false-colour picture 
was done using the UV, blue and 
green channel and by omitting the red 
channel. 
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Real colour Colour we see Colour the bees see Colour we see in the 
false-colour picture 

UV Black Bee-Ultraviolet Blue 

Blue +UV Blue Bee-UV-Blue Cyan 

Green +UV Green Bee-Purple Purple 

Red +UV Red  Bee-Ultraviolet Blue 

Blue Blue Bee-Blue Green 

Blue +Green Cyan Bee-Blue-Green Yellow 

Blue +Red Purple Bee-Blue Green 

Green Green Bee-Green Red 

Green +Red Yellow Bee-Green Red 

Red Red Bee-Black Black 

White -UV White Bee-Blue-Green Yellow 

White +UV White Bee-White White 

Black -UV Black Bee-Black Black 

Black +UV Black Bee-Ultraviolet Blue 

Grey -UV Grey Bee-Blue-Green Yellow 

Grey +UV Grey Bee-Grey Grey 

 

 

FIGURE 6. Histogram of a picture taken with the blue filter. On the left: Picture without adjustments. It is clearly visible that the blue channel 
of the picture is overexposed. On the right: The same picture after adjusting the brightness. The peak of the blue channel is now located in the middle 
and has the correct brightness. 

For the normal picture we used the white balance dropper 
tool with the grey standard as a reference point to set the white 
balance. 

Merging the photos in Adobe Photoshop 

The prepared green, blue and UV pictures were opened in 
Photoshop as layers. At this point every picture still consists 
of three colour channels (RGB). By using the command 
“Image > Apply Image” we discarded the channels not 
needed. Figure 7 shows the settings that we used to discard 

the green and the red channel of the blue image/layer. This 
command overwrites the blue image with its own blue colour 
channel. 

We used the same dialogue to overwrite the green image 
with its own green colour channel and to overwrite the UV 
image with its own red channel. 

Using the command “Layer > Layer Style > Blending 
Options” we converted the layers into their new colour 
channels. Under “Advanced Blending” we unchecked the 
colour channels not needed. For example: The blue image  

TABLE 1. Colour 
Translation Chart 
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FIGURE 7: The “Apply Image” dialogue in Photoshop. The 
layer with the blue image gets overwritten with its own blue colour 
channel. The not needed green and red channels get discarded. 

becomes the new green channel so we unchecked “R” and “B” 
(Fig. 8). 

In some cases, the images are a little bit shifted to one 
another. To compensate this, we re-aligned the images by 
clicking “Select > All Layers” and “Edit > Auto-Align 

Layers”. We used the projection method “Reposition” or 
“Auto”. If this method did not work we aligned the layers 
manually using the “Move Tool”. 

If the grey standard was photographed next to the flower 
it should be grey in the false-colour image as well. If it shows 
a colour tint the new created colour channels are not perfectly 
equally bright. These small colour shifts were corrected by 
using a “Levels Adjustment Layer”. By creating a new empty 
layer in the uppermost position and using the shortcut “Ctrl 
+ Alt + Shift + E” (on Windows) we merged the whole false-
colour picture to a single layer. With the “Marquee Tool” we 
selected the surface of grey standard and blurred the selected 
area with the command “Filter > Blur > Average”. This 
ensures that the influence of the grainy structure of the 
standard and noise from the camera's sensor are as small as 
possible. 

We created a “Levels Adjustment Layer” by clicking 
“Layer > New Adjustment Layer > Levels” in the uppermost 
position. By using the Tool “Sample in image to set grey 
point” on the blurred area this layer corrects all the colours in 
the image using the grey standard as a reference (Fig. 9). 

 

 

 

FIGURE 8. The “Blending 
Options” dialogue in Photoshop. 
Under “Advanced Blending” we 
can decide to which colour channel 
the image/layer gets converted to. 
This figure shows the settings for 
the blue image/layer that gets 
converted to the new green channel. 

FIGURE 9. Levels 
Adjustment Layer. If the grey 
standard was photographed in 
separate pictures and not next to 
the flower we also converted these 
photos into a false-colour picture 
and followed all described steps. 
Then we copied the “Levels 
Adjustment Layer” to the false-
colour picture of the flower. The 
pictures were saved in the 
Photoshop PSD format and as 
JPGs (8 Bit, sRGB). 
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Merging the photos in ImageJ 

To verify the merging process and to show an alternative 
to Photoshop we also merged some images using ImageJ and 
the plugin “MICA Toolbox” (Troscianko & Stevens 2015). 

Because we used special colour filters we had to create a 
custom *.txt file that tells the program which colour channels 
from which image are getting used (Fig. 10). How this works 
shall not be explained in detail in this paper because there is a 
comprehensive user guide available on the programmer’s 
website. 

To merge the images, we opened ImageJ used the 
command “Plugins > Multispectral Imaging > Generate 
Multispectral Image”. In the upcoming dialogue we adjusted 
some settings. Under “Settings” we chose our custom *.txt file. 
All other settings are visible in Fig. 11. 

After starting the process by clicking “OK” ImageJ 
automatically asks for the different pictures and guides the 
user through different steps that we followed. First, we opened 
the green image containing the grey standard and selected the 
standards surface area. Then the program asks for the green 
image without the standard. The steps repeat with the blue 
and the UV image. In between we manually aligned the images 
since we selected “Manual Align” (Fig. 11). 

When all images were opened and aligned we used the 
command “Plugins > Multispectral Imaging > Tools > Make 
Presentation Image“. In the following dialogue box, we 
decided that the green channel of the green image becomes the 
new red channel, the blue channel of the blue image becomes 
the new green channel and the red channel of the UV image 
becomes the new blue channel. We also chose “Square Root” 
under “Transform” and checked the “Convert to RGB 
colour” box (Fig. 12). 

By clicking “OK” the program merges the images to a 
false-colour image. We saved the images as JPEG files. 

Interpretation of false-colour pictures 

In order to test the value of false-colour photography we 
studied floral colour changes and floral colour patterns and 
compared false-colour pictures and UV-pictures as a basis for 
the interpretation of the flower colours as seen by bees. A 
series of false-colour pictures of sub-alpine and alpine flowers 
were taken to test the reliability of this method. Whether the 
results of false-colour photography are similar with deviant 
equipment, deviant picture processing and different filters 
were also tested by using the selected flowers.  

 

FIGURE 10: The custom *.txt file created to tell the program 
which colour channel to use. 

 

FIGURE 11. The settings that were used to create a false-colour 
image with ImageJ. We told the program that the grey standard was 
captured in separate photos and that is moves between them. We also 
set the reflectance to 20%. Under ‘Alignment & Scaling’ we chose 
manual align. We set the output to ‘Aligned Normalised 32-bit’. 

RESULTS 

Colour change 

Floral colour changes in the Shrubby Milkwort Polygala 
chamaebuxus (Polygalaceae) affects the conspicuousness of 
the post-change colour in the false-colour picture but is not 
detectable in the ultraviolet range of wavelength (Fig. 13 A, B, 
C). The pre-change as well as the post-change colour of the 
Common Lungwort Pulmonaria officinale (Boraginaceae) are 
reflecting ultraviolet light and are conspicuous for bees 
according to the false-colour picture (Fig. 13 D, E, F). The 
Field Forget-me-not Myosotis arvensis (Boraginaceae) 
displays a yet undescribed threefold colour change. The 
purplish early flowing phase and middle bluish flowering 
phase display a colour change visible to the human eyes. But 
the flower petals also change from UV-absorbing to UV-
reflecting. This colour change is visible to bees’ eyes but 
invisible to the human eyes. The colour change from the 
bluish and UV-absorbing middle flowering phase to the 
equally bluish late UV-reflecting flowering phase is visible to 
bees’ eyes as is the colour change from human-yellow to 
human-white of the floral guide (Fig. 13 G, H, I). 
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FIGURE 12. Dialogue box to select that the green channel from 
the picture taken with the green filter becomes the new red channel, 
blue channel from the picture taken with the blue filter becomes 
green and the red channel from the picture taken with the UV filter 
becomes blue. 

Bull’s eyes 

Bull’s eye refers to colour patterns that highlight the 
rewarding center of a flower. Some of these bull’s eyes are 
visible to bees but invisible to humans (e. g. UV bull’s eyes). 
Some colour patterns can be visible to humans too, but there 
are also non-UV colour patterns that are invisible to humans. 
The Yellow Archangel Lamium galeobdolon (Lamiacae) 
displays a typical all-yellow flower colour and an additional 
ultraviolet bull’s eye resulting in a conspicuous colour pattern 
in bee view (Fig. 14 A, B, C). The flower displays two shades 
of yellow which are congruent with the UV-pattern (Fig. 14 
A, B, C). The Marshmarigold Caltha palustris 
(Ranunculaceae) is uniformly yellow, but nevertheless displays 
a bee-visible colour pattern due to a pattern of reflection in 
the ultraviolet light (Fig. 14 D, E, F). The Yellow Daffodil 
Narcissus pseudonarcissus (Amaryllidaceae) shows no 
ultraviolet, but a blue bull’s eye resulting in a colour pattern 
visible to bees (Fig. 15). The Key of Heaven Primula veris 
(Fig. 16 A, B, C) and the Oxlip Primula elatior (Fig. 16 D, E, 
F; Primulaceae) have all-yellow flowers, reflect uniform in the 
ultraviolet range of wavelength, but nevertheless display a 
colour pattern visible to bees. The Great Mullein Verbascum 

phlomoides (Scrophulariaceae) has all-yellow flowers and 
displays an ultraviolet bull’s eye. Due to an additional blue 
bull’s eye the floral colour pattern is rather complex in bee 
view (Fig. 17). 

Tiny structures 

False-colour pictures are able to display small-scale floral 
colour patterns visible to bees as shown for stamens and florets 
of the Cornflower Centaurea cyanus (Asteraceae) (Fig. 18 A, 
B, C) pollen and white staminal protuberances of the Flower-
of-an-hour Hibiscus trionum (Malvaceae) (Fig. 18 D, E, F), 
a colour gradient of small-sized floral guides of the Round-
Leaved Saxifrage Saxifraga rotundifolia (Saxifragaceae) (Fig. 
18 G, H, I) and the androeceum of the Wood Anemone 
Anemone nemorosa (Ranunculaceae) (Fig. 18 J, K, L).  

Didactics 

The conspicuousness or inconspicuousness of human-red 
flowers for bees’ eyes is dependent of the ultraviolet reflection 
as demonstrated for the UV-reflecting flower of the Winged 
Pea Lotus tetragonolobus (Fig. 19 A, B, C; Fabaceae) and the 
Red Poppy Papaver rhoeas (Fig. 19 G, H, I; Papaveraceae) as 
well as the UV-absorbing flower of Forrests Rhododendron 
Rhododendron forrestii (Fig. 19 D, E, F; Ericaceae). The 
underside of the petals in the Lousewort Pedicularis gruina 
(Orobanchaceae) display a rare white and UV-reflecting 
colour (Fig. 19 J, K, L), whereas the white flowers Common 
Snowdrop Galanthus nivalis (Amaryllidaceae) stand out 
against the snow due to absorption of ultraviolet light (Fig. 
19 M, N, O). The Bittersweet Nightshade Solanum 
dulcamara (Solanaceae) displays yellow anthers and green 
floral guides on the petals with possess a similar colour for 
bees (Fig. 19 P, Q, R).  

Colour pattern of sub-alpine and alpine flowers on 
the mountains of eastern Himalayas 

A series of photos taken under field conditions in the 
surroundings of the Lijiang Forest Ecosystem Research 
Station operated by the Kunming Institute of Botany, Chinese 
Academy of Sciences (China) using automatically controlled 
exposure to light for UV-photos and for colour photos, a 
single white balance value for all colour photos and another 
for all UV-photos and later manual adjustment of the 
brightness of the channels reveals satisfactory results (Fig. 20, 
21). This equipment was easily carried on an international 
flight and proved to stay functional at high altitude with low 
temperature, low oxygen and high UV-radiation. The 
Edelweiss flower of Leontopodium sp. (Asteraceae) possesses 
hairy petals inaccessible to spectrophotometry (Fig. 20 A, B, 
C). The white part of the fused dorsal petals of the Lousewort 
Pedicularis cephalantha (Orobanchaceae) displays a colour 
that is rarely found in bee-pollinated plants, i.e. a white and 
UV-reflecting colour (Fig. 20 D, E, F). The flower of Tibetia 
yunnanensis (Fabaceae) displays a white, yet UV-absorbing 
floral guide similar to pollen-mimicking floral guides 
described above (Fig. 20 G, H, I). The flower of Primula 
poissonii (Primulaceae) possesses no UV-pattern, yet a bee-
visible floral guide (Fig. 20 J, K, L). The flower of Salvia 
hylocharis (Lamiaceae) displays an unusual type of floral 
guide absorbing all visible wavelengths as well as ultraviolet 
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FIGURE 13. Colour pictures 
(left), UV-pictures (middle) and 
false-colour pictures (right) of floral 
colour change in Polygala 
chamaebuxus L. (A, B, C), 
Pulmonaria officinalis L. (D, E, F), 
and Myosotis arvensis Hill (G, H, I). 

 

FIGURE 14. Colour pictures 
(left), UV-pictures (middle) and 
false-colour pictures (right) of bull’s 
eyes in Lamium galeobdolon (L.) (A, 
B, C) and Caltha palustris L. (D, E, 
F). 

 

FIGURE 15: Colour picture, 
UV-picture and false-colour picture 
of Narcissus pseudonarcissuss L.. 
Additional pictures show the blue 
channel and the green channel. 
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FIGURE 16. Colour pictures (left), UV-pictures (middle) and 
false-colour pictures (right) of Primula elatior (L.) (A, B, C) and 
Primula veris L. (D, E, F). 

 

FIGURE 17. Colour picture, UV-picture and false-colour 
picture of Verbascum phlomoides L.. Additional pictures show the 
blue channel and the green channel. 

 

FIGURE 18: Colour pictures (left), UV-pictures (middle) and 
false-colour pictures (right) of Centaurea cyanus L. (A, B, C), 
Hibiscus trionum L. (D, E, F), Saxifraga rotundifolia L. (G, H, I) 
and Anemone nemorosa L. (J, K, L). 

light (Fig. 20 M, N, O). The pollinators of Paris polyphylla 
(Melanthiaceae) are still unknown (Ren et al. 2014); although 
the flower displays no UV-pattern it has a bee-visible colour 
pattern (Fig. 20 P, Q, R). The Saxifrage Saxifraga 
signata (Saxifragaceae) possesses flowers with tiny yellow 
protuberances that uncommonly reflect ultraviolet light and 
might mimic the colour and gloss of nectar in addition to 
orange and UV-absorbing floral guides (Fig. 21 A, B, C). The 
yellow flower of Potentilla griffithii (Rosaceae) displays basal 
orange floral guides on each petal that are also visible to bees 
which, however, cannot be read from the UV-picture (Fig. 21 
D, E, F). The yellow flower of the Lousewort Pedicularis 
longiflora (Orobanchaceae) displays two red floral guides 
which are invisible on the UV-picture, but clearly visible on 
the false-colour picture (Fig. 21 G, H, I). The flowers of the 
Lousewort Pedicularis tricolor (Fig. 21 J, K, L; 
Orobanchaceae) and of Trollius yunnanensis (Fig. 21 M, N, 
O; Ranunculaceae) display different shades of yellow and no 
UV-pattern which results in clearly bee visible colour pattern.  

Robustness to changes in equipment and 
processing 

We compared different false-colour images using the 
three colour filters with false-colour images that were taken 
with just the UV-/IR-Cut filter and the UV filter (Fig. 22 A, 
B). The principal details about the colour change of Myosotis 
arvensis (Fig. 13, see above) are also found using deviant 
techniques. For the merging of the false-colour photos Adobe 
Photoshop (Fig. 22 C) and ImageJ (Fig. 22 D) were 
compared.  

Using different cameras and lenses also revealed similar 
results; even the use of a cheap plastic lens with less 
transmittance of ultraviolet light than the quartz lenses seem 
adequate for creating false-colour pictures (Fig. 23). 

To see if the method works without setting the white 
balance we created a false-colour picture without any 
brightness adjustments. The camera was set to auto (Fig. 24 
A). We also used styrofoam as a reference standard to match 
the brightness levels in post (Fig. 24 C) to see if styrofoam 
can be a cheap alternative to grey standards. For reference we 
also took a false-colour image by using a spectralon grey 
standard and the described method (Fig. 24 D). 

The result shows that the automatically exposed false-
colour picture without adjustments has a green colour cast 
(Fig. 24 A). The camera overexposed the blue channel because 
the flower and the background don’t reflect a lot of blue light. 
Because of the blue filter the camera sees a dark picture and 
tries to compensate by overexposing the picture. This leads to 
a green colour cast in the false-colour image (Fig. 24 A). This 
problem can be solved by not using the blue and green filter 
and instead splitting the normal RGB image that were also 
taken by using the automatic exposure (Fig. 24 B). The 
resulting image looks similar to the false-colour picture taken 
with the grey reference standard (Fig. 24 D). This method 
however can still lead to colour casts since camera sees a dark 
picture through the UV filter and compensates by 
overexposing. 
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FIGURE 19. Colour pictures (left), UV-pictures (middle) and 
false-colour pictures (right) of Lotus tetragonolobus L. (A, B, C), 
Rhododendron forrestii B. Balfour ex Diels (D, E, F), Papaver rhoeas 
L. (G, H, I), Pedicularis gruina Franch ex Maxim. (J, K, L), 
Galanthus nivalis L. (M, N, O) Solanum dulcamara L. (P, Q, R). 

Using the styrofoam as a reference standard dramatically 
improves the results using the colour filters (Fig. 24 C). The 
false-colour image looks very similar to the false-colour 
picture taken with the grey reference standard (Fig. 24 D). 

DISCUSSION 

In this study a low-cost and easy-to-use multispectral 
imaging equipment is proposed and the advantages of false 
colour imaging over UV-photography and 
spectrophotometry are explained with some examples. Our 
equipment was proved to be effective to detect new floral 
color patterns and to be efficiently working in a high elevation 
mountain region in the Himalayas.  

The equipment is configured for false colour photography 
in bee view. Bees use colour cues of flowers to find nectar and 
pollen sources (von Frisch 1915; Dyer at al. 2014; Orban & 
Plowright 2014). Experiments with honeybees and 
bumblebees have shown that flower visits consist of a series of 
behavioural reactions mostly based on visual cues. Initially 
bees are colour blind in their search for flowers in that they 
process only input to the green type of photoreceptors (Giurfa 
et al. 1996). Only if the visual angle viewing the target flower 
surpasses a threshold the bees use colour vision to find flowers 

(Dyer et al. 2008). Naïve and inexperienced bees’ innate 
colour preferences guide them towards promising flowers 
(Lunau & Maier 1995; Lunau et al. 1996). Bees exhibit a 
preference for flowers displaying colour contrast against the 
background (Lunau et al. 1996), flower colours of high bee-
subjective saturation (Lunau et al. 1996), and prefer distinct 
colour hues, bee-subjective blue in the first place (Giurfa et al. 
1995; Gumbert 2000; Milet-Pinheiro et al. 2015). When 
bees have approached a distinct flower, floral colour patterns 
are important for the flower to guide the bees towards a 
suitable site for the first physical contact with the flower by 
means of the antennae, landing (Lunau et al. 1996) and 
proboscis extension (Wilmsen et al. 2017). Floral colour 
patterns may include small-sized structures such as floral 
guides, veins, staminodes, stamens, anthers, filamental hairs 
and others (Lunau & Wester 2017; Lunau et al. 2017). False 
colour images show flower colour patterns as seen by bees 
although the bee colours are visualized as human visible 
colours, UV as blue, blue as green and green as red (Kevan 
1978, 1983; Kevan and Backhaus 1998). False colour images 
of flowers in bee view have been introduced several times 
(Kevan 1972; Vorobyev et al. 1997; Chittka and Kevan 2005; 
Benitez-Vieyra et al. 2007; Williams & Dyer 2007; Brito et 
al. 2015; Hempel de Ibarra et al. 2015). In this study, the  
 

 

FIGURE 20. Colour pictures (left), UV-pictures (middle) and 
false-colour pictures (right) of flowers taken under field conditions 
in Lijiang (Yunnan, China). Leontopodium sp. (A, B, C), Pedicularis 
cephalantha Franch. ex Maxim. (D, E, F), Tibetia yunnanensis 
(Franch.) Tsui (G, H, I), Primula poissonii Franch. (J, K, L), Salvia 
hylocharis Diels (M, N, O), Paris polyphylla var. yunnanensis 
(Franch.) Hand.-Mazz (P, Q, R). 
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FIGURE 21: Colour pictures (left), UV-pictures (middle) and 
false-colour pictures (right) of flowers taken under field conditions 
in Lijiang and Shangri-La (Yunnan, China). Saxifraga signata Engl. 
et Irmsch. (A, B, C), Potentilla griffithii var. velutina Card. (D, E, F), 
Pedicularis longiflora Rudolph (G, H, I), Pedicularis tricolor Hand.-
Mazz. (J, K, L), Trollius yunnanensis (Franch.) Ulbr. (M, N, O). 

 

FIGURE 22. False-colour picture of Myosotis arvensis L. 
merged from photos taken with UV, blue and green filter (A), 
merged from photos taken with UV filter and the UV-/IR-Cut filter 
split into colour channels (B), Adobe Lightroom and Photoshop (C), 
and ImageJ and MICA Toolbox (D). 

advantages of false colour imaging over UV-photography and 
spectrophotometry are clearly demonstrated by multiple 
examples, especially by the undetected colour pattern of sub-
alpine and alpine flora on the high mountain of eastern 
Himalayas in China. 

Interpreting flowers as seen by bees requires the 
consideration of ultraviolet and bee-visible ranges of 
wavelength (Kevan 1978, 1979, 1983), although ultraviolet 
reflections in general are not more important than blue or 

green ones (Kevan et al. 2001). Rarely the bees’ lower 
sensitivity in the red range of wavelength has brought into 
focus (Cure & Wittmann 1990; Chittka & Waser 1997; 
Lunau et al. 2011; Bergamo et al. 2016). The fact that bees 
are red blind or less sensitive to red light has caused lot of 
confusion about how bees might perceive red colours (Hinton 
1976; Johnson & Midgley 2001; Rodríguez-Gironés & 
Santamaría 2004; Martínez-Harms et al. 2010). It was found 
that some bees have developed sensitivity in the red range of 
wavelength (Cure & Wittmann 1990; Chittka & Waser 1997) 
or the red colour of flowers is used to exclude bee as 
potentially nectar-robbing flower visitors (Lunau et al. 2011; 
Bergamo et al. 2016), since bees see red colours without 
additional reflection in the UV as black. Sensory exclusion of 
bees was also proposed for white, UV-reflecting bird-
pollinated flowers, since UV-reflecting white colours are not 
spontaneously preferred by bees (Lunau et al. 1996; 2011). In 
the Lousewort Pedicularis gruina a similar phenomenon is 
demonstrated for the buds of the violet flowers which display 
the white, UV-reflecting underside of the petals. The 
Snowdrop Galanthus nivalis represents the common type of 
white bee-pollinated flowers (Kevan et al. 1996). In the Red 
Poppy Papaver rhoeas (Papaveraceae) the red flowers in the 
Eastern Mediterranean are pollinated by red sensitive 
glaphyrid beetles (Martínez-Harms et al. 2012), whereas the 
flowers in the Western part of Europe have evolved reflection 
in the red range of wavelength are pollinated by bees 
(Burkhardt 1997).  

Floral colour change is known as a semi-honest indicator 
of floral nectar reward (Lunau & Wester 2017). The fact that 
the flowering phase offering reward is attributed with a more 
attractive colour (Lunau 1996) is nicely demonstrated with 
the false-colour picture of Myosotis arvensis. In the Lungwort 
both the pre-change as well as the post-change flower colour 
seem to be attractive to bees (Oberrath & Böhning-Gaese 
1999) which is supported by false-colour pictures of a related 
Pulmonaria species. However, false-colour pictures might 
reveal yet unknown details of floral colour changes (Weiss & 
Lamont 1997; Ohashi et al. 2015). The bee view might be 
enhanced if the optical resolution is also considered 
(Rodríguez-Gironés & Ruiz 2016; Lunau & Verhoeven 
2017). 

One typical pattern is the so-called ultraviolet bull’s eye 
(Silberglied 1979; Schlangen et al. 2009; Koski & Ashman 
2014) of all-yellow flowers displaying a UV-reflecting 
periphery and a UV-absorbing center part either by pollen, 
anthers of pollen-mimicking floral guides (Lunau 2000, 
2007; Lunau et al. 2017). In this study an all-yellow flower 
displaying a blue bull’s eye as well as all-yellow flowers 
displaying a bee-visible colour pattern with different shades of 
yellow were found. It is known that the centre part of floral 
colour pattern directs the bees’ approaches towards the first 
physical contact and landing site of flowers due to higher 
colour saturation and colour contrast against the corolla 
(Lunau et al. 1996; Papiorek et al. 2013; Wilmsen et al. 
2017). In many cases the ultraviolet picture does not indicate 
the higher salience of the flowers’ centre part rather than the 
false-colour picture. Even the absence of UV-reflection 
pattern is of significance for flower visitors, e.g. for yellow 
bird-pollinated flowers (Papiorek et al. 2013), and for yellow 
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FIGURE 23. Colour pictures (A-D) and false-colour pictures (E-H) of the Pilewort Ficaria verna L. (Ranunculaceae) taken with different camera 
equipment which was Panasonic GH-1 camera and Pentax 85 mm Ultra Achromatic Takumar lens (A, E), Panasonic GH-1 camera and 105 mm UV-
Nikkor lens (B, F), Nikon D40 camera and 18-55 mm Nikkor lens (C,G), and Nikon D40 camera and 105 mm UV-Nikkor lens (D, H). 

 

FIGURE 24: Bellis perennis A: False-colour picture taken with the camera set to auto and using the colour filters. The picture 
was assembled without any adjustments. B: False-colour picture taken with the camera set to auto. The picture was assembled without 
any adjustments and by splitting the RGB image. C: Before merging the pictures to the false-colour picture the brightness of the pictures 
were adjusted so that the styrofoam has the exact same brightness in every colour channel (white balance). D: False-colour image 
assembled by using the spectralon grey reference standard. 

 

Crocus species (Lunau et al. 2016). A common type of 
colour pattern in all-yellow flowers is the combination of an 
orange floral guide with a yellow periphery without any UV-
pattern like in the California Poppy Eschscholzia californica 
(Papaveraceae) and Common Toadflax Linaria vulgaris 
(Plantaginaceae). It is still an open question whether and how 
this colour pattern is able to direct flower visitors towards the 
centre part of the flower (Lunau 1992). If the spectral 
reflectance in the ultraviolet and blue ranges of wavelengths 
are negligible the orange colour might appear darker to the 
bees than the yellow colour and thus appear more bee-
subjective saturated, since darker colours appear at least to 
humans more saturated than lighter colours of similar chroma 
(Lübbe 2010). 

The false-colour images will be helpful for plant-
pollinator interaction studies in these underexplored regions, 
such as Himalayas. We demonstrated the diversity of floral 
colours on the high elevation mountains in Lijiang and 
Shangri-La, eastern Himalayas. These flowers of the Chinese 
flora reveal a large diversity of bee-visible colour pattern which 
has not yet been described to our knowledge despite high 
intensity of studies in visual aspects of pollination biology in 
China (Shi et al. 2009; Eaton et al. 2012; Huang et al. 2015; 

Ma et al. 2015; Zhang et al. 2017; Tao et al. 2018; Yan et al. 
2018). Unusual flower colour patterns were detected in the 
bumblebee buzz-pollinated genus Pedicularis and indicated a 
highly diverse signal system in this genus. On the mountains 
of southwestern China, Pedicularis species exhibit a 
spectacular level of endemism and floral diversity (> 300 
species; Yang et al. 1998). The different Pedicularis species 
are pollinated by the same bumblebee species, but the floral 
mechanisms that ensure pollen deposits and pickups on 
different parts of the pollinator’s body ("Pedicularis-type" of 
mechanical isolation) were well characterized in a few co-
existing species in China (Wang & Li 2005; Tong & Huang 
2016, 2018; Liang et al. 2018). However, the visual and 
olfactory signal aspects of this model system have not been 
explored yet.  

The flora of China is extremely diverse with more than 
30,000 species of angiosperms (Wu et al. 2013). The 
mountains of southwest China are regarded as one of global 
hotspots of biodiversity with the highest diversity of species 
and endemism of all temperate floras (Myers et al. 2000). The 
floral diversity of high elevation mountains of this region is 
strongly shaped by generalist bee species, such as Chinese 
native honeybee Apis cerana and bumblebees (Ren et al. 2014; 
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Zhao et al. 2016). This region harbours the half of global 
species of bumblebees (Williams et al. 2009). The limited 
number of false-colour photos presented in this study indicate 
that the diverse bee pollination system in Himalayas requires 
more researches on their visual signals in the future. Our low-
cost and easy-to-use multispectral imaging equipment will be 
helpful for the future when we explore these understudied 
areas.  

In conclusion, this study shows that false colour images of 
flowers in bee view provide similar information as classical 
UV-photos and additional information about the floral 
colour pattern that is not available from UV-photos. The false 
colour images of flowers are easy to interpret due to the 
consistent bathochromic shift for about 100nm during the 
reassembling to the false colour image resulting that all kinds 
of bee-visible colour patterns are seen as patterns rather than 
uniform colours. This also holds for very tiny structure like 
pollen grains, anthers, filamental hairs, and veins which is 
advantageous compared to spectrophotometry. 

APPENDICES 

Additional supporting information may be found in the online 
version of this article:  

APPENDIX I.  Estimated costs for a low-budget version and 
an optimal equipment for false colour photography in bee view. 
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